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XC32: v2.30 B BHHT
Harmony 3:

*  bsp(v3.5.0)

* c¢sp(v3.5.0)

* core (v3.5.0)

*  mhc(v3.5.0)

* dev_packs (v3.5.0)
* gfx(v3.5.0)

* gfx_apps (v3.5.0)
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=. f£IJE MPLAB X IDE T8

VE: PR R HTHE 77, td B 1 T A2 2 A

(—) #Fr#E Harmony 3 T H

7E MPLAB X IDE H. /5 5 File -> New Project, 1E+%“32-bit MPLAB Harmony Porject”,
SRJE i “Next” $%4H.

4 New Project *
Steps Choose Project
1. Choose Project Q, Filter:
2. ..
LCategories:

i+ Other Embedded
..@ samples =] Existing MPLAB IDE v8 Project

[ Prebuilt (Hex, Loadable Image) Project
G User Makefile Project

[ Library Project

=] Import START MPLAB Project

& Import Atmel Studio Project

Description:
MPLAB® Harmony Project Wizard

< Back Finish Cancel Help

EFE “Harmony Framework” HISERREER, SAJ5 M “Next” #4241,

B4 New Project pd
Steps Manage Framework
1. Choose Project
2. Framework Selection Use the Content Manager tool to download or configure a local framework.
3. Project Settings
4. Configuration Settings I Launch Content Manager l
Framewaork Path: D:\Microchip\harmony\Harmony3 J

[«| Canvert to Relative Path for Confiquration

< Back Next = Finish Cancel Help

HE T H BARAIH 248K, )5 s “Next” 24
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B3 New Project Py
Steps Hame and Location
1. Choose Project
2. Framework Selection Location: C:\Users\A50814'\Desktop\temp'harmony\GFX2 )
3. Project Settings
4. Configuration Settings Folder: GFX2

Name: GRX2

Path: C:\Users\A50814\Desktop\tempiharmony\GFX2\firmware\GFX2.X

< Back Einish Cancel Help

R4 Starter Kit R0 F, B PSS B 28704 PIC32MZ2064DAS169 ”, H¢ Ji M. 17 Finish ”
Y25 o

B4 New Project

>
Steps Configuration Settings
1. Choose Project
2. Framework Selection Name: default
3. Project Settings
4. Configuration Settings
Device Family: | All ~ | Target Device: I PIC32MZ2064DAS169 I ~

Device Filter: PIC32MZ2064DAS

Show Visual Help

< Back Next > Cancel Help

(=) EEE MHC

F—RQEBEHKN, MHC A< A3NES). 8EF3N7E X IDE B A Tools ->
Embeded -> MPLAB Harmony 3 Configurator J33/]:

3 MPLAB X IDE v5.30 - GFX2 : default
File Edit View Navigate Source Refactor Production Debug Team Tools Window Help

7 3 ) @ [defout v % -9+ D | Embedded
Licenses
Projects x| Files | Classes | Services Packs
=+ GFX2 )
Apply Diff Patch...

[ 1mportant Files
=8 Linker Files Templates

Source Files DTDs and XML Schemas
[ Libraries
[=-[EF Loadables

Plugins
Plugins Download

Options




MICROCHIP

M1l Launch #2541

2 MPLAB Harmony Launcher X

Active Project Information:

Name: default

Select an option to use for the launch paths for the MPLAB Harmony Framework tool suite:

@ MPLAB Harmony Project Path - The framework path that is stored with this MPLAB Harmony project. Reconfigure Paths

Harmony Path: D:\Microchip\harmony\Harmony3

() MPLABX Path - The framework path that is stored with MPLABX (configured through Tools->Options-=Harmony)

Harmony Path: D:\Microchip\harmony\Harmony3

Default Launch Action: | Prompt For Path Selection (This... ~
(Configurable through Tools->0Options->MPLAB Harmony)

Launch Cancel

1l Launch 241

2 Configuration Database Setup X

Configure Device Family and CMSIS Pack Paths:

DFP: A\dev_packs\Microchip\PIC32MZ_DA_DFP\1.0.81\atdf\PIC32MZ2064DAS169.atdf | E

CMSIS: Adev_packs\arm\CMSIS\5.5.1 ! =

Launch Cancel

MHC S~ K.

2 MPLAB Harmony Configurator - default - O X
File Generate Tools Utilities Window

I > P |C-®E‘Z_"_=’ Framework: C:\microchip\H3_installpath,
(] Available Components = F4 53| (] Project Graph = Ff B3| |(] configuration Options =FH 0
+ X‘EEEE*EE‘ View: |Root ~||([EH

Board Support Packages (BSPs) ) = System

Graphics Device Family Pack (DFP) Device & Praject Configuration
Harmony Cortex-M7 Configuration

#-Clock (PMC)
Ports (PI10)
Interrupts (NWVIC)

Input

Libraries
Peripherals

Third Party Libraries
Tools

Hi-

(] Available Components [ Active Components (1 Configuration Options (] Help

(] Console =508

<Harmony Database->[Info]: create component: AT24 Driver ~
<Harmony Database=[Info]: create component: AT25 Driver
<Harmony Database=[Info]: create compone DHC Driver
<Harmony Database->[Info]: create component: SDSPI Driver
<Harmony Database-[Info]: Load mModule: Harmony TCP/IP Stack
<Harmony Database>»[Info]: create component: usB Driver
<Harmony Database>[Info]: create component: USB Device €DC
<Harmony Database->[Info]: create component: USB Device Audio
¢ DatahaseslInfol: create ¢ - MSB Deyice HIND

Welcome to the MPLAB Harmony Configurator!
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70 BSP, #4”PIC32MZ DA Starter Kit
Fl)”project Graph” & I

BSP” M ”Available Components” & [ 4 i

2 MPLAB Harmony Configurator - default

File Generate Tools Utilities Window

(] Available Components = &

4

#- Applications

+ Audio

+ Bluetooth

E} Board Support Packages (BSPs)
.~ Default Board (BSP

| CEEEE -
- Bootloader

- Graphics

# Harmony

- Input

- Libraries

#- Peripherals

- Third Party Libraries

- Tools

] Project Graph
X CRERE4| = |

Device Family Pack (DFP)

PIC32MZ DA Starter Kit BSP

[EFETTVE, USHNAEAR “Aria Graphics w/ PDA TM4301B Display” .
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2 MPLAB Harmony Configurator - default*

File Generate Tools Utilities Window

(] Available Components = FF B3/ |(] Project Graph
a4 x||§....f||i||f||\|’|ew Root
- Default Board (BSP) ~
& Bootloader | System |
L Graphics
& Displays
- Driver
~ GFX Core
& Interface
& Middleware
¥ Processor
= Templates

----- Aria Graphics w/ OLED1 Xplained Pro Display

----- Aria Graphics w/ PDA TM5000 Display

----- Aria Graphics w/ Xplained Pro Display

----- Legato Graphics w/ MXT Curiosity Pro Display
----- Legato Graphics w/ PDA TM4301B Display

----- Legato Graphics w/ PDA TM5000 Display v
< >

(1 Available Components | (] Active Components |

EVR IR “Aria Graphics w/ PDA TM4301B Display” 2 J&, <> H B3 H— R%%}
TEAE, AR PIERE, AR
WINE TS B BN A ASAAE N 2 A, 1B % ves.

Confirm Component Auto-Activation? X

I.e_-‘ The database is requesting auto-activation of the following components:

Core (HarmonyCore)

Input System Service (sys_input)

GFX Core (gfx_hal)

Aria (aria_gfx_library)

PDA TM4301B (gfx_disp_pdatm4301b_480x272)
MaxTouch Controller (gfx_maxtouch_controller)

Are you sure you want to activate these components?

Yes MNo

A BRI FreeRTOS, AWIATEZE 0S, #EFE Noo



e\

MICROCHIP

Confirm Component Auto-Activation? X

'e The database is requesting auto-activation of the following components:
FreeRTOS (FreeRTOS)

Are you sure you want to activate these components?

| Yes || No |

Bl e i HhiEL, EHE ves.

Confirm Attachment Auto-Connect? >

'a The database is requesting automatic connection following component attachments:
gfx_hal:gfx_display -= gfx_disp_pdatm4301b_480x27 2:gfx_display
aria_gfx_librany:gfx_hal -= gfx_hal:gfx_hal
gfx_maxtouch_controllertouch_panel -» gfx_disp_pdatm4301b_480x272:touch_panel

Are you sure you want to automatically make these connections?

Mo
WA E SR A AR, WEEE yes.
Confirm Component Deactivation? *

'Q The following components are going to be deactivated:

Are you sure you want to deactivate these components?

Yes MNo

M2 S50 GLCD, GPU £l DDR %%, 1E#% yes.

10



e\

MICROCHIP

Confirm Component Auto-Activation?

GLCD {(gfx_driver_glcd)
12C1 (i2c1)

12C (drv_i2c)

CORE TIMER. ({core_timer)
TIME (sys_time)

DDR (ddr)

ZDGPU (gfx_driver_2dgpu)

Yes

Are you sure you want to activate these components?

MNo

X

Ia The database is requesting auto-activation of the following components:

Bl e s HahiEL, WEFE yes.

Confirm Attachment Auto-Connect?

Yes

gfx_hal:gfx_display_driver -> gfx_driver_glcd:gfx_driver_glcd
drv_i2c_O:drv_i2c_12C_dependency -= i2c1:12C1_12C
gfx_maxtouch_controlleri2c -= drv_i2c_0:drv_i2c
sys_time:sys_time_TMR_dependency - > core_timerCORE_TIMER_TMR
gfx_hal:gfx_graphics_processor -> gfx_driver_2dgpu:gfx_driver_2dgpu

Are you sure you want to automatically make these connections?

No

et

'ﬂ The database is requesting automatic connection following component attachments:

RiEEH CHEL, TR E.

11
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L] Project Graph =
X|E.E.-’|EE|| View: | Root

Device Family Pack (DFP) PIC32MZ DA Starter Kit BSP

Caore Input System Service
Harmony Core Service System Service

o RTOS Input System Service
Core Service O

GLCD GFX Caore
GLCD Display Driver Hardware Abstraction Layer
PDA TM4301B Display Dn've Graphics Display —
480x272 PCAP Display — Display Driver Eits L=
Graphics Display Tv“" 2DGPU Graphics Processor Input System Service
Touch Panel Graphics Processor
i GFX HAL HAL
Graphics Processor GFX

12C1 i2C
Paripharal Library Driver MaxTouch Controller
2c <" o Core Service Touch Controller

I — < Input System Service
Instance 0 S

I2c ‘ Touch Panel
DRV_I2C

CORE TIMER i TIME
Peripheral Library System Service
TMR O Core Service

SYS_TIME ©
TMR

NP R, T EAEREIKA) X frame buffer 5, % Project Graph
H1 ) GFX Core 2044, 7E Configuration Options H1/4Ji% Double Buffer Mode.

ault\defaultxml* — X

Framework: D:\Microchip\harmony\Harmony3\

= F 1| (] Configuration Options =B
View: |Root vl |E F

=+ GFX Care
#-Draw Pipeline Configuration
Display Settings

PIC32MZ DA Starter Kit BSP

IéJ Display Driver Information

- Driver Info Function Mame |driverGLCDInfoGet
~Driver Init Function Name  |driverGLCDContextInitial
Graphics Processor Information

GFX Core | B Driver Configuration Hirts

Hardware Abstraction Layer - Display Color Mode GFX_COLOR_MODE_RGBA_
=~ Graphics Display — - Global Palette Mode
. > Display Driver Graphics Library - Double Buffer Mode I
Input System Service ~Aggressive Refresh ]

GFX HAL ~Hardware Layer Count 3

1

12
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MR HR IR E, S 44 mT DU BRI R TT .
2 MPLAB Harmony Configurator - default?
File Generate Tools Utilities Window

I 3 p |:,;.:—.'::'

2 Save Database State As

Save in: default

v BcFE-

A
<3
Recent Items

[ |
Desktop

Documents

|

This PC

@ File pame: default.xml
Network  Fijes of type: | = xml e Save selecte

(=) f#H MHGC(Microchip Harmony Graphics Composer) 8! i3+
MHC 2% Tools-> Graphics Composer 3K i3 /] MHGC.

File Generate Tools Utilities Window

P o Clock Configuration

| Display Manager
0 Available Col DMA Configuration -9
L Graphics Composer
= Board S MPU Configuration >Ps)
NVIC Configuration
! Pin Configuration
= Grabhics

FET PR T A ey 58— N2 A project wizard B — MBI EE 8L

13
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2 Welcome Dialog

P Graphics Composer
——

Welcome to the MPLAB Harmony Graphics Composer user interface design application.

Please select from one of the choices below to get started. You can also click the close button to begin using the tool

without guided assistance.

E] Create a new project using the new project wizard.

G Load an existing design from an MPLAB Graphics Compaser data file.
——

/ Use design loaded from current MHC configuration.

[ pon't show this dialog again.

Close

Color mode 1E#% RGBA 8888, #AJ& it Next 241

2 New Project Wizard

Color Mode
Memory Size
Project Type
Finish

H@v Grap hics Composer
-

Color Mode Selection

Select the color mode to use for this project. The color mode determines the color
depth, pixel storage format, and memory requirements for the design.

Not all display devices and display drivers support all color modes. You must
ensure that your display device and driver support the selected color mode

(Jes_s 8 bits Greyscale

O RGB_332 8 bits 3 bits red, 3 bits green, 2 bits blue

O RGB_565 16 bits 5 bits red, 6 bits green, 5 bits red

O RGBA_5551 16 bits 5 bits red, 5 bits green, 5 bits blue, 1 bit alpha

O RGB_888 24 bits 8 bits red, 8 bits green, 8 bits blue

RGBA 8888 32 bits 8 bits red, 8 bits green, 8 bits blue, 8 bits alpha

O ARGB_8888 32 bits 8 bits alpha, 8 bits red, 8 bits green, 8 bits blue

[ ]use Global Color Palette  The global color palette provides the means to use hoth
8 bit frame buffers and display 16-32 bit color depth.
The limitation is that the color palette of the design is

limitad tn 258 ralare Tha dienlaw drivar et cinnnet

Estimated size of a single frame buffer (bytes): 522240

Note: Your display driver may require additional configuration in MHC beyond
what is shown here.

Next Cancel

14
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Flash memory size ff FHERIAME, #RJ5 i Next #2461

2 New Project Wizard *

Purscl Graphics Composer
o

Color Mode Memory Size Configuration
MEIT‘IOI'V Size Use the controls below to configure the amount of flash memory you want to use for
memaory consumption analysis. Additional memory sources can be added through the
PI’GjECt TYP'E "Memory Location" configuration window.
Finish
Flash Memory Size (bytes): 524,288 5
Previous Cancel

1 $¢”Start a new project using a basic template”, RI{f FHZEAlRMN, S8 )5 midh Next
Fikl

2 New Project Wizard e

Burue§ Graphics Composer
-

Color Mode New Project Contents

Memcry Size Select from one of the choices below regarding the state of the new project.
PI‘OjECt TVPE () Start a new project using a completely blank design.

Finish @ BStart a new project using a basic template. This template includes a single screen,

Previous MNext Cancel

5o B 58 i, Screen Designer T 1 H EIL AR AR 1) T o

15
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2 MPLAB Harmony Graphics Composer* — m] X
File Edit View Asset Tools Window
BRoexun e =@ Q[ 8|50~ X v | o
(] Tree View = E¥ 1| (1 Sereen Designer - screent = E¥ B/ (1 widget Tool Box =5
ey o7 ~ || B widgets ~
?&'xﬂj' s | 480 D Arc
- Iﬁqudget I } Ik  Bar Graph
Lo A TitleLabel Button
b
SloganButton MPLAB Harmony Graphics Composer 6 E.h:\ﬂ( Box
~ (A Circular Gauge &
(] Screens = B0 MPLAB‘ (] Properties Editor = 70
pi o |8 -
X nmtd HARMONY
Generate Visble Name View v E‘;;ﬁj” <creent ~
v | vl |screen1 | = = Size [480,272]
Orientation DEGREES 0
(1 Schemes | hodify. Gensrate. Run | Et‘:gn{:je
Ll | x » >+ Persistent |:| v
- =1 Fuante
< >
v
(Mouse over a property for detailed help)
screenl X
a
== > T H
T AR B, 44, IF 5T Delete Selected Object
2 MPLAB Harmony Graphics Composer®
File Edit View Asset Tools Window
BEOE8o 0@ Q[ B30~
[ Tree Vi = ¥ B/ (] Screen Designer - screent = F
{343 4 F &L
- 480
= 3 LayerD |
v = Lot Delete Selected Objects (D'D)J | (479.0)
- A TitleTane
: ; MPLAB Harmony Graphics Composer
or
s X mmitd 212 HARMONY
Generate Visible Name View v—
v v screenl -_—
o _ o o
9 Modify. Generate. Run. iO
(] Schemes =B of 2] o}
TEX D3P £
| (0,271) (479,271}

i FSEHLK) Asset->DDR Organizer K41 JF DDR Organizer & [, 1%+ PIC32MZDA
Internal DDR 32MB £ & Memory Profile, i Load #%4H, & H I 6 4> Frame

Buffer.

16
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(] DDR Organizer = A=
Load Memory Profile: |\PIC32MZDA Internal DDR 32MB P || Load
Memory Size
Start Address: Ox AB0OOOOO :
Size (bytes): 0x 200000015

Usage Metrics (bytes)
Used: 0x 2FDO00

Available: Ox 1D03000

Frame Buffers

Use DDR for Frame Buffers

Known Memory Consumers

‘ il dik K Auto-sort Mode: | Manual ~

Type Name Size (Bytes) Offset
FrameBuffer  |[Frame Layer 0 Buffer 0 7F800 0
FrameBuffer Frame Layer 2 Buffer 1 7FB00 7FB00
FrameBuffer  |[Frame Layer 2 Buffer 0 7FB00 FFODO
FrameBuffer  |[Frame Layer 1 Buffer 1 7F800 17E800
FrameBuffer  |[Frame Layer 1 Buffer 0 7F800 1FEQOD
FrameBuffer Frame Layer 0 Buffer 1 7F800 270800

GLCD H =4 Layer, &1~ Layer #}45 X{ Frame Buffer, T LLELHE45 6 4> Frame Buffer.
HAETA TR MR T Layero, PTBASEhr A ZE]T 2 4 Frame Buffer.

7E Tree View H % Layer0, 7E Properties Editor 7 1+ 1% & Buffer Count A 2,
Rli% & Layer0 {¥ XL Frame Buffer.

2 MPLAB Harmony Graphics Compos

File Edit View Asset Tools Window
Paese iaw = =€
(] Tree View

Z2aX|rTe e

= LogoWidget
A TitleLabel

17
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[] Properties Editor

E" 7 %! ]
Name LayerQ
Position [0,0]
Size [480,272]
Scheme
Optimization Flags [false,false,false]
El Layer
Enabled
Alpha Blending []
Alpha Amount 255
Background Type Fill
Transparency Enabled []
Input Rectangle [true,true]
[ Layer Buffer Configuration
|Buffer Count 2 |
Buffer 0 [Auta]
Buffer 1 [Auta]
VSync Swap

M Widget Tool Box % -4 1} Image Sequence %1 Screen Designer.

C B |20 X394 Y1110 | 100%
(1 Screen Designer - screend = B B3| (] widget Tool Box =

S

Circular Gauge s

(ﬂ.ﬂ)_! I (479,0) Circular Slider

Draw Surface

Gradient

Group Box

Image Plus

Image Sequence I
Image

Key Pad

MPLAB Harmony Graphics Composer

e R

PP CGEA 55

272 HARMONY et y
\v/' Tt (] Properties Editor =HO

[= Screen ~
MName screent
Size [480,27.
Orientation DEGREE
Mirrored

» B

(0,271) (479,271

W B position J4(160, 100), ¥ & Size JN(160, 160), % & Background Type N None

18
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(] 1 [
sdh| 84
= Widget ~
Name ImageSequenceWidget
[=l Position [160,100]
X 160
Y 100
[l Size [160,160]
Width 160
Height 160
Enabled [v]
visible
Border [Mone]
Margin [4,4,4,4]
Scheme (7]
| Background Type None w |
Alpha Blending [
Optimization Flags [false,false,false]
=l Image Sequence "
Canmanen Canfinieatinn Rislan (|
(Mouse over a property for detailed help)

M 38 Asset -> Images >KF]F Image Assets Manager

File Edit 'u"lewﬁ Tools Window

ﬁ&“ﬁ‘id Memory Locations e | ¢ E|3 0 -~
4 M =iriL) Clfamomr:

Fonts

String Table Configuration
Strings |

7E Image Assets Window, Aiii Add Image From File SRININE A

Add lmase From FiIeI

1%E# Jump0.bmp~Jump7.bmp

19
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2 Import Image File x
Look in: Labg i c¥ E-
@ Ei Jump0.bmp
[~ Ei Jump1.bmp
Recent Items EJumpZ.bmp
Ei Jump3.bmp
- Bl Jump4.bmp
LE T Ei Jump5.bmp
Ei Jump6.bmp
& Ei Jump7.bmp
Documents
Thils;.-F’C
@ File name: ump3.bmp" "Jump4.bmp" "JumpS5.bmp" "Jump6.bmp" "Jump?.bmp"
Metwork

Files of type: |= = v Cancel

ok, mMEEIRTE flash WA =S R A AR AL B A 2o RE,  7E Image
Asset 7 1,

a) EH“Jump0”

b) & & Color Mode 2y RGB565, R [&] 1 LA RGB565 4% U AFfiff 7E flash H

c) ‘AJi% Color Masking & 1 HE

d) & Mask Color (31, 0, 31), BIEFHMEE RE. XMHEE RS

i, RIEN.

Xt Jump1~ump7 EE UL D,

20
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Size (bytes): 51200

Memory Location: |1nterna| Flash

Resize Crop | Reset

(Mouse over a property for detailed help)

Fixel Mode COLOR =
=l Image Output Settings
Format
Color Mode | RGB 565 _|
- NewHarmonyLogo_Small E't_s Per E’|xe| 16
Unique Pixel Count 148
Palette Compression ] Oy ?
Data Compression Mode MNope 00 ‘ @
Color Masking !
&l Mask Color M [31,0,31] [
Red 3
Green 0
Blue 31 v

Bff: ¥ & Mask Color [ 7b—FJ71%, s Color Mask 4711 ... 4% 40

BEZaX Size (bytes): 51200
- grg?ges Memaory Location: |]nternal Flash V|
- Jumpl Resize Eropl Reset
- Jump2 OO oo ET_TET
-~ Jump3 Pixel Mode COLOR ~
- Jump4 &=l Image Output Settings
- Jump5 Format Raw w
~Jumps Color Mode RGB 565 v
tji;‘l_rlr[‘;f Bits Per Pixel 16
- MicrochipLogo Unigue Pixel Count 148 ) ?
Palette Compression ‘ @
Data Compression Mode | None | \
Color Masking I
Mask Color B[31,0,31]
[=l Preprocessing
Enabled ] b
(Mouse over a property for detailed help)

skt X RS B, i s oK.

21
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2 nul

Click in the image to select a color:

= B S

] | Cancel

2T R IX L Image NI E] Image Sequence #2447
&7 ImageSequenceWidget1

2 MPLAB Harmony Graphics Compos

File Edit View Asset Tools Window
Paseiap e =R
(] Tree View = 5
23X +TFeE
=l &3 LayerD

- b= LogoWidget

® B ImageSequenceWidgetl

’R)i% Repeat Hi%ME, i Sequence Configuration Dialog A7 321 i...4%4H

22
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[] Properties Editor = FF B
§‘ 7 Et ]
Enabled ~
visible
Border [Mone]
Margin [4,4,4,4]
Scheme b | I
Background Type None
Alpha Blending
Optimization Flags [false,false,false]

=l Image Sequence
Sequence Configuration Dialog E

Starting Image 0
Play By Default ]
Repeat
[l Events
Image Changed [] h

(Mouse over a property for detailed help)

L
TEFH H 1) Image Sequence Configuration Dialog XiG#EAH, M Ad — RN

L
image entry. —3L# 8 4~ image entry, FTLARTE S 8 I 74 .

(=]

< Image Sequence Configuration Dialog *
LAhLD 4R KT
Image Horizontal Alignment  Vertical Alignment Duration (...
e | JUMDO ba Cente ddle
-— ~ | Center Middle 1000
= InewHarmonylLogo_Small Center Middle 1000
- Center Middle 1000
- Center Middle 1000
- Center Middle 1000
- Center Middle 1000

7F image 1=, st FHAHE, BT AREA entry IEFE—)> image. X4 entry
I s e T S A 1) image I & U -

23
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2 Image Sequence Configuration Dialog *
tEX(*T S &
Image Horizontal Alignment  Wertical Alignment Duration (...

= | Jump0 Center Middle 1000

= | Jump1l Center Middle 1000

e | Jump2 Center Middle 1000

e | Jump3 Center Middle 1000

e | Jump4 Center Middle 1000

e | Jump5 Center Middle 1000

e | Jumpt Center Middle 1000

= | Jump7 Center Middle 1000
B B B A U bR b, T AT R A

2 Image Sequence Configuration Dialog et
tEX T+ &
Image Horizontal Alignment  Vertical Alignment Duration (...

e | Jump0 Center Middle 1000

&= | Jumpl Center Middle 1000

e | Jump2 Center Middle 1000

| | Jumn3 Center Middle 1000

E Center Middle 1000

E Center Middle 1000

E Center Middle 1000

E Center Middle 1000
sl Exit S8 PRSI AE o

24
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M Widget Tool Box #f H} Button %I Screen Designer-.

(] Screen Designer - screenl = Ff B3| (] widget Tool Box = ]
= widgets ~
) Arc

480
o | | a7

Check Box
Circle

Circular Gauge
Circular Slider
Draw Surface
Gradient

MPLAB Harmony Graphics Composer

__________

HARMDNY : {maqe Plus

\v/' {1 Properties Editor = 5

2 A
all| 2l

=
L % = Screen ~

SACEA >20KE

¥ MName screent
id Size [480,272]
B Orientation DEGREES 0 ~
1) (47 Mirrored
= Life Cycle

% B Button ] Position J4(0,0), & B Size N(480,272), % B Background Type N
None, ¥ & Border Type N None, BI3%4HK 78 o BN G5 o

[] Properties Editor

§‘ 7 %! ]
= Widget
Name ButtonWidget1
=] Position [0.07
X 0
b i]
E Size [480,272]
Width 480
Height 272
Enabled [+
Visible
=l Border [Mone]
| Type None |
Margin [4,4,4,4]
Scheme
|Background Type Hone |
Alpha Blending
Optimization Flags [false,false,false]
[= Button
Toggleable []
Text String
[+ Alignment [Center,Middle]
Custom Line Spacing |:|
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File Edit View Asset Tools Window
o iap e (R E|C

T (] Tree View

EELIEE

= 4 O

i = LogoWidget
= A TitleLabel
: L Nalflg e

Td
® M ButtonWidgetl

2N R ER I (1 4% R /Pressed MR N, FIRIEAF ButtonWidgetl, fE

properties editor H1/2)i% Pressed HiEHE, AN 2.

[] Properties Editor = FF B
E" 7 %! ]
Scheme ~|[7] ™
Background Type None d
Alpha Blending
Optimization Flags [false,false,false]
= Button
Toggleable []
Text String W
[+ Alignment [Center,Middle]
Custom Line Spacing
Pressed Image e
Released Image o
Image Position LeftOf d
Image Margin 10
Pressed Offset 1
= Events
Pressed @
Released N s W

1E 3 H 1Y) Event Editor XT1EHEH, /AT Create New Action %41

Event Editor - Pressed

| ¥ B ¢

Mews

ICreate New Acti0n|

ST,

pressed.

Action List:

Edit Delete Move Up Move Down

Pressed - This event is generated when the corresponding button widget is

>
4

Ok

1% Custom, A Next, RF-ZN% S FAFm BACHS
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| | Action Edit Dialog

*
Name:
Select the type of action to create:
O Template Template actions are created using & wizard-based approach. The user will be guided through a series

of questions involving: selecting an action target, choosing an action to perform, and inputting required
argument values.

Custom actions consist entirely of user-defined code segments. In this mode whatever code the user

inputs into the text field will be inserted into the auto-generated code files verbatim. Mo error checking
or validation is performed.

Cancel

Next

7E# H I Action Edit Dialog T 5 LAY APP_TriggerAnimation(); % PR < J5 513
1EE 1) 476 T8

| £ | Action Edit Dialog X

MName:

Custom Action Definition:

APF TriggerAnimation();

Cancel Previous Finish

2 J5 15 A5 Finish, T 5 OK,

[A] 2, %F Event Released (FZ#H R 51 A4 o) I ) A SR AL 34 , /& Custom Action
Definition 385 /09 /& APP_StopAnimation(); 1% BRI %2> 152 152 ) 1) 3 i

B TR A A, fraF LREIF IS MHGC,
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File Edit View Asset Tools Window
Bapexusieajaacs

0 save Desian -28¢

(70) 4 F MHC 2 FRARAS
WIRARAF I AR 2 R B o BARIE 22 30 : “MPLAB® Harmony 3 2 :filli i (02)
- T fi# MHC”,

IREX A=

() #IARAS

£ project & HHXUHATIT app.c XA
B4 MPLAB X IDE v5.30 - GFX2 : default

File Edit View Mavigate Source Refactor Pr

E % I_ @ default

Projects XT Files I Classes T Services
=G 6RX2

+-E Header Files

ﬁ Important Files

-- Linker Files
B Source Files

P main.c
ﬁ Libraries
+-[EF Loadables

7E app.c FESINUN T 2068 AR AR S
#include "gfx/libaria/libaria_init.h"
#include "gfx/libaria/inc/libaria_widget_imagesequence.h"
static bool play = false;
uint32_t delayCount = 0;
void APP_TriggerAnimation(void) //4% iz ]
{
play = true;
lalmageSequenceWidget_Play(ImageSequenceWidget1);
}

void APP_StopAnimation(void) //15 1L 4% X
{
play = false;
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lalmageSequenceWidget_Stop(ImageSequenceWidgetl);

void APP_Tasks ( void )
{

case APP_STATE_SERVICE_TASKS:

{
if (delayCount++ < 25000)
break;

delayCount = 0;

if(play)
{

lalmageSequenceWidget_ShowNextlmage(ImageSequenceWidgetl);
}

break;

1E project & I H X FTH app.h SCHF
4 MPLABE X IDE v5.30 - GFX2 : default

File Edit View Navigate Source Refactor Pr
PEHES D E

Projects XI Files I Classes I Services

F-I0 config
-- osal
-- packs
[ Important Files
H-F Linker Files
E—:I-- Source Files
) app.c
H{F config
LB main.c
#-[i& Libraries
+-[EF Loadables
-G ush_cdc_bridge

7E app.h 0
void APP_TriggerAnimation();
void APP_StopAnimation();
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(75) i B T BRI

i ESE U File -> project properties SRF] JF project properties X7 1A
4 MPLAB X IDE v5.30 - GFX2 : default

File Edit View Mavigate Source Refactor Produ

] New Project...
#9 New File..

Open Project...
Open Recent Project

Import

Close Project (GFX2)
Close Other Projects
Close All Projects
Open File...

Open Recent File

Project Groups...

Ctrl+Shift+N
Ctrl+N

Ctrl+Shift+0

Project Properties (GFX2)

AT A PR A A XC32 G 1 A%

B3 Project Properties - GFX2

Categories:
@ General
# @ File Inclusion/Exclusion
& o

----- @ PICkit 3
Loading
Libraries
Building
¥C32 (Global Options)
0 xc32-as
xc32-gec
c32-g++
xc32-1d
%c32-ar
Code Coverage

e e @ e @

Manage Configurations...

Configuration
Family:

All Families

Supported Debug Header:

None

Packs:

Hardware Tool:

Device:

PIC32MZ2064DA5169 ~

Supported Plugin Board:

None

Compiler Toolchain:

. Packs

<

[ | PIC32MZ-DA_DH

>

. Hardware Tools
@ Atmel-ICE

o 10D 4

o0 PICKIt3
- PM3
-0 Real ICE
-2 Simulator
@0 Snap
Alternate Tools

ITAGICE3
mEDBG
PICkit2

i PKOR nann

<

B ¥SN: JIT175210091

>

. Compiler Toolchains

< >

*Tip: double click on serial number (SN) to use a friendly name (FN) instead.

Cancel

Apply Unlock Help

(B) 4wiE T EHAA
1. YmPF N #

e T B L EAR DR AT I B I T BT -
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T8 P12 - E-

B, EWRHERNE, SRR, A LN FEBEER S .

ISE

AN T Image IS SLIBM LS5 5tilG, FFIH Image Sequence %
PN B B T, S Bl R

BE £ Harmony3 [ GFX {5 B 1S % .

Harmony3 %35 H 5% \gfx_apps\

Harmony3 “Z3& H 3% \gfx\doc
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